Chapter – 3
RESEARCH METHODOLOGY

3.1) Introduction

In the light of the present study, this chapter covers all the research methods used in the study, the primary data, secondary data sources are mentioned. The sample, sample size, and sample procedure is explained in the present topic. The statistical tools used and their significance in the present study are discussed in the detail in the various sections of the topic. The present chapter covers the variables used in the study to observe the operation of retailers, hypermarkets and wholesalers. Data presentation in form of tools of presentations like tables is given. The graphical presentations of data and interpretations regarding various parameters and their significance to small grocery shopkeepers, wholesalers and the hypermarket managers are mentioned using Pie charts and column graphs.

After setting the objectives of the topic, researcher has prepared a questionnaire for the small grocery shopkeepers, wholesalers and the hypermarkets. Various parameters are formulated which will present the data related to functioning of organized and unorganized retailers. The small grocery shopkeepers, wholesalers and authorities of the hypermarkets are handed over the questionnaire by the researcher, which includes the various parameters such as space and various facilities and other related issues.

The variables taken for the study are defined in respective sections of results and discussion from section A of the chapter 4 to F section of chapter 4.

The main purpose of this study was to determine what variables have the most impact on the state of the grocery retail trade and customer's views in form of their perception, attitude and services offered to them. In order to compile a list of potentially significant variables, a thorough review of existing literature was completed as described in the previous chapter. Microsoft Excel 2003 and SPSS v16 was used in the statistical analysis of the variables.
The following steps outline the methodology for this study –

1) Selecting a set of variables for analysis, which represent the literature on grocery trade and its related elements.

2) Master sheet is prepared of the data Collected.

3) Master sheet of the data is helpful for analyzing the frequencies of each variable and then finding out meaningful correlations (Spearman’s rho coefficient) between the variables and then measuring customer’s preference for organized and unorganized retail trade.

4) Determine the most significant relations in the data and perform additional explorations as needed to explain the relations.
Finding out meaningful conclusions from the data analyzed.

3.2) Research methods and data collection –

In first phase of the study, observational analysis is made regarding quantitative growth of the hypermarkets in Kolhapur city. In second phase, the research design is carried out to analyze the problem.

Primary data – Primary data was directly gathered from customers, small grocery shop owners, hypermarket authorities and wholesalers.

Secondary Data – Secondary data was gathered mainly from research articles, books on retail management, magazines and other publications from conference proceedings. The details are mentioned in bibliography.

Questionnaire Method – The formal instrument in form of questionnaire is developed to test the state of grocery retail trade and different problems associated with retailers, hypermarkets, wholesalers and customers.

3.3) Designing of Research Instrument –

The research tool used for the study i.e. questionnaire has main four purposes. Firstly to collect the relevant data, secondly to, make the data comparable, thirdly to minimize the bias and lastly to motivate the respondents for proper responses. The research instrument helps in classifying the data based on the details of the
respondents. The respondents opinion about the retailers and present business scenario will be understood from the research instrument i.e. questionnaire.

After reviewing the objectives of the research, the questionnaire was constructed. In order to cover various dimensions about grocery retail trades, organized retailers and unorganized retailers are considered for the data gathering. The customers and their opinions, which were previously studied, by the Pershuraman, Zeithmal and Berry in various stages (1988, 1994, 2001, and 2006) are taken as a reference for the consideration of the data related with the customer’s perceptions, services offered and role of brand in grocery retailing. At the same time, the reference of the pyramid model developed by Kevin Keller (1993; 2001; 2003) is referred. The model is termed as customer based brand equity (CBBE). In the branding model, Keller describes different stages through which customer undergoes before making purchase decision. The Kellers model has pyramid shape. The bottom stage of branding model starts with satisfaction of the needs of the customers. The second stage starts with different characteristics and features based upon product reliability, Durability, Serviceability, price and design of the product. In the third stage, model gives emphasis upon the characteristics such as fun, excitement, security that are not significant in the grocery retailing. In the top stage of the business model, the focus is provided upon the factors such as loyalty, attachment, engagement. Model also covers brand awareness, Brand attributes, Brand benefits, images, thoughts, experience, attitudes and feelings. The third reference for developing questionnaire is a taken from book —Service Quality Management in Hospitality and Tourisml by Joy Kandompully, Connie Mok and Beverley Sporks, published in arrangement with Howorth Hospitality press 2008. This book gives the reference of the tools developed on service quality by (Berry and Parasuraman, 1991). The tool includes three levels of service - essential, expected and optional. The book described that service providers need to establish service standards. Author states that service standards affect the business performance. Customer services are developed into three continuums i.e. before purchase, during purchase and after purchase of the product or the service. Before purchase, service includes the customer’s awareness about the retailer, working hours of the retailers, the parking facilities provided by the retailer. This phase also includes the greeting of the customers. During purchase, the factors such as physical facilities, ambience, location, layout, check in and
checkout system, payment mechanisms etc. After purchase, involves the factors such as no of customers, computerized billing, packaging of purchased material, promptness in the service and complaint handling etc.

**Observation Method** – Researcher has used the observation method in order to compare various aspects like merchandising, parking facility, ambience etc in case of the hypermarkets. Researcher has made remarks on his own on these parameters related with every hypermarket.

### 3.4) Population, sample Procedure, sample plan, sample size and sample size estimation

**A) Population:**

Researcher has used target population in form of customers visiting both grocery trades, customers shopping only from organized grocery retail trades and customers shopping only from unorganized retail trades. Further, from the population of wholesalers and small grocery shopkeepers are considered as a sample for the study.

A research population is also known as a well-defined collection of individuals or objects known to have similar characteristics. A research population is generally a large collection of individuals or objects that are the focus of a scientific query. To understand the opinion of population researches are done. However, due to the large sizes of populations, it is difficult to test every individual in the population because it is too expensive and time-consuming. All individuals or objects within a certain population usually have a common binding characteristic.

**B) Sample procedure:**

The researcher has developed the sampling procedure in line with the work done by ICRIER 2008. The categories of the retailers are broadly divided into two types. They are organized retailers in form of the hypermarkets and unorganized retailers in form of small grocery shopkeepers. Kolhapur city has 4 hypermarkets. Lucky
bazaar, Big bazaar, Vishal and D Mart. These four hypermarkets are having space more than 25000 sq. ft. In this research, unorganized retailers are defined as the retailers having the space less than 500 sq feet for the operation.

The Kolhapur has 1300 small grocery shops out of which 70 % are having less than 500 sq. ft. to operate with. Therefore, approximately 800 small grocery shopkeepers, which are valid for research, spread throughout Kolhapur city.

Geographically Kolhapur city is divided into five words, namely A, B, C, D, and E. The samples of these shopkeepers are taken from each of these wards as researcher found that most of the small grocery shopkeepers registered, do exist in these wards.

**Use of random table for selecting small grocery shops –**

Random table is used to select the random numbers from small grocery shops and formula in MS-Excel is used to select the random number for small grocery shops. The details are given in appendices.

**C) Sampling plan:**

The researcher has selected 30 respondents belonging to small grocery shopkeepers in case of ward A, B, C, D and purposely 105 respondents from ward E. this is because all the hypermarkets in the Kolhapur city are located in only one ward i.e. E ward. Following table shows the sampling distribution of all the retailers. Researcher has taken one respondent from every ward from wholesaler's category and all the hypermarkets for the study.

**Table 3.1 - Table showing sampling plan of the distribution of retailers –**

<table>
<thead>
<tr>
<th>Category</th>
<th>Ward A</th>
<th>Ward B</th>
<th>Ward C</th>
<th>Ward D</th>
<th>Ward E</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Small Grocery Shops</td>
<td>30</td>
<td>30</td>
<td>30</td>
<td>30</td>
<td>105</td>
<td>225</td>
</tr>
<tr>
<td>Hypermarkets</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>Wholesalers</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>5</td>
</tr>
</tbody>
</table>
Researcher has divided the sample of the customers over four hypermarkets (125 customers from each hypermarket). Researcher has selected 8 small grocery shops and 25 respondents from each for the study. The third category of the customers selected by the researcher is the customers shopping only from hypermarkets. 100 customers from D Mart and 50 customers each from big bazaar as well as lucky bazaar are taken for the study.

Following table shows sampling distribution of the customers –

**Table 3.2 - Table showing sampling plan of the customers from three segments**

<table>
<thead>
<tr>
<th>Category of Customers</th>
<th>Distribution of customers</th>
<th>No. of Customers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shopping from both</td>
<td><strong>Hypermarket</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Big Bazaar</td>
<td>125</td>
</tr>
<tr>
<td></td>
<td>D Mart</td>
<td>125</td>
</tr>
<tr>
<td></td>
<td>Lucky Bazaar</td>
<td>125</td>
</tr>
<tr>
<td></td>
<td>Vishal</td>
<td>125</td>
</tr>
<tr>
<td></td>
<td><strong>Total sample size of customers</strong></td>
<td><strong>900</strong></td>
</tr>
<tr>
<td>Shopping from only small grocery shops</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Big Bazaar</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>D Mart</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Lucky Bazaar</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td><strong>Total sample size of customers</strong></td>
<td><strong>900</strong></td>
</tr>
</tbody>
</table>

Source: Questionnaire of the customers
D) Sample size:

Exit interviews of 500 customers shopping from both hypermarkets and small grocery shops are taken for the study. Exit interviews of 200 customers shopping only from small grocery shops at various locations (8) are also taken for the study. A separate sample survey of 200 customers shopping only from hypermarkets is taken for the study. Thus, total sample size of the customers becomes 900 for the study.

Two hundred and twenty five (225) small grocery shopkeepers from the various wards of Kolhapur city are selected. 30 small grocery shopkeepers from ward A, ward B, Ward C and Ward D each and 105 shopkeepers from ward E are taken for the study. All the 4 hypermarkets are selected as samples in the category of organized retail trade. The survey of customers is taken at every hypermarket using random sampling. The respondent’s exit interview is taken for the survey. One hundred and twenty five (125) respondents are surveyed at the time of leaving the hypermarkets.

Total 1216 questionnaires were distributed among the respondents, out of which 316 questionnaires are incomplete because respondents shown negligence and
reluctance to complete the questionnaire. Only 900 valid questionnaires are taken for the further study.

**E) Sample size Estimation:**

The sample size for the research is taken using the sample size calculations developed by Roscoe and published in the book entitled —Research methodology— by the author Uma Shekran. In this book, the author states that, sample size greater than 30 and less than 500 are appropriate for most of the research. He further states that when sample needs to be broken into sub-sample based on gender or profession and income groups, a minimum sample size of the 30 for each category is necessary. He further states that in multivariate analysis the sample size should be ten times greater than the variables taken for the size.

In order to select small grocery shops on random basis, use of the table of random numbers becomes inevitable. Three digits random number from the table is consider as a members for the present study.

**F) Measurement and scale used for the study:**

The research component of the study consists of a self-administered questionnaire. The questionnaire designed used several questioning techniques. The study employed five point Likert scaled questions, multiple choice rating questions, dichotomous questions, close-ended questions and single answer questions respectively. Categorical scale and dichotomous questions provides easiness of understanding and flexibility. The questionnaire was pre-tested amongst 50 respondents and shown to two faculties of marketing.

- Small, unorganized retailer’s response was taken using **dichotomous questions**.
- Five point Likert scale is used to know and understand customer's opinion.
- **Nominal scale** is used in order to decide gender of the employee.
- The income group of the customers taken for the study falls under the **categorical scale**.
- In order to test the branding strategies of the grocery products fixed or **constant sum scale** is used.
Pre testing of the questionnaire – The questions, which were not understood, are deleted from the questionnaire. Few questions, which were confusing, are dropped. The group of 50 customers was asked about the statements.

G) Selection of type of distribution:

As the research consists of large sample size, the data falls in the category of the normal distributions. In this case many frequencies falls on the normal curve and many parameters are consistent. For the Likert’s scale _1’ score is given for the strongly disagree criteria and _5’ score is given for the strongly agree criteria .The scores are equally distributed from score 2 and 4 which has been labeled as _disagree‘ and _agree‘.

3.5) Data coding and demographic variables used for the study

The data grouping is the most important step in data coding. The classification based on the demographic variables is the first stage of the data coding. The demographic variables include the factors like age, gender, occupation, education, and income level, place of shopping and frequency of shopping. The customers are numbered from 1 to 900 serially. For the above-mentioned demographic variables, the coding considered for data processing is as follows –

Coding used for Gender of the respondents –

For the variable _gender‘, 1 is considered for male and 2 for female for small grocery shop keepers, managers of hypermarkets and wholesalers. The gender of the all segments of the customers is coded in the same way.

Coding used for Education of the respondents –

For the education, one is considered for the customers having education below graduation, 2 for the customers who are graduates and 3 for the customers who are postgraduates. The gender of the all segments of the customers is coded in the same way.
Coding used for Age of the respondents –

The age wise distribution is made using continuous distribution which started from the age 20 and the difference is taken of 5 years i.e. 20 to 25 years, 25 to 30 years, 30 to 35 years, 35 to 40 years and last is 40 years and above.

Coding used for Occupation of the respondents –

For the occupation, one is given for the customers in service, two is for the customers who are businessmen, three for the students, four for the customers who are retired from the service, five for the housewives (unemployed), six for the farmers.

Coding used for Income level of the respondents –

In case of income level of the customers, the income level is decided based on class interval of Rs. 5000. So, 1 is given for the customers having income level < 5000. 2 is for the customers falling in the income group of Rs. 5000 to Rs. 10000. 3 is assigned for the customers in the income group of Rs. 10000 to Rs. 15000. 4 is assigned for the customers in the income group of Rs. 15000 to Rs. 20000. 5 is assigned for the customers in the income group Rs. 20000 to Rs. 25000 and 6 is given for the customers having income more than or equal to 25000.

Coding used for Customers from three different segments –

The customers shopping from both retail trades are assigned 1. The customers shopping from only unorganized retailers i.e. small grocery shops are assigned the number 2 while customers shopping from only hypermarkets are assigned number 3.

Coding used for Hypermarkets –

The hypermarkets taken for the study are also assigned the no. s as 1 for Lucky Bazaar, 2 for D Mart, 3 for Big Bazaar and 4 for Vishal Mega mart. The data gathered is categorically divided in three different types. These types are
Coding used for customer’s perception, attitude, opinion about sales promotion, services offered and role of brand –

Scale consists of the numbers from 1 to 5. 1 stands for strongly disagree, 2 stands for disagree, 3 stands for neutral response, 4 stands for agree and 5 stands for strongly agree.

Variables for Identification of the data – Identification of the data consists of names, addresses, phone, ward and place of the interview.

Variables for Classification of the data – Classification of the data in the research instrument consist of education, age, gender, occupation of the head of household, income group and other relevant data.

Variables for Subject Data – Subject data gives the emphasis upon the different objectives for which the survey is conducted. In this research, various parameters are set for testing the opinion of the respondents in terms of their perception, attitude, and their opinion about the role of branding in grocery retailing. These parameters are mentioned in respective sessions.

3.6) Data Presentation and Analysis –

Tables and Graphs – Tables and graphs are visual representations. They are used in the study to organize information to show patterns and relationships between different variables related with retailers, hypermarkets, wholesalers and customers. Pie charts are used to show percentages. Column charts are used to show comparisons between different groups and variables.

Validity and Reliability Testing of the data - One widely accepted classification of validity consists of three major forms: Content, criterion-related, and Construct.

Content Validity - In order to test the content validity researchers has shown the questionnaire to the two professors of marketing. Further, the questionnaire is then circulated to 50 customers to understand the doubts what respondents ask.
while giving the response. Understanding about the questionnaires by the customers is important because then only the proper response about the questionnaires will be expected. If the questionnaire adequately covers the topics that have been defined as the relevant dimension, it can be concluded that the instrument has good content validity. Determination of content validity is judgmental and can be approached in several ways.

**Construct Validity** - While doing the pilot study, 50 respondents are chosen. To test construct validity, questionnaires are circulated and their interviews are taken. Largely both instruments give results, which are co-related.

**Statistical package used - The SPSS environmental –**

SPSS for windows provides a powerful statistical analysis and data management system in a graphical environment, using descriptive menus and simple dialogue boxes to do most of the work for you. Most tasks can be accomplished simply by pointing and clicking the mouse.

In addition to the simple pointing – and – click interface for statistical analysis, SPSS has eight different types of windows:

**Data Editor** - The data editor is a versatile spreadsheet – like system for defining, entering and displaying data. This window opens when you start an SPSS session and displays the content of the data file.

**Viewer and Draft Viewer** - The viewer makes it easy to browse your results, selectively show and hide output, change the display, order result and move presentation – quality tables and charts between SPSS and other applications. This window opens automatically the first time you run a procedure that generates some output.

**Private table Editor** - Output displayed in pivot tables can be modified in a number of ways. Using editor, it is possible to edit text, rearrange rows, columns and layers, add colors, create multidimensional tables and selectively hide and display results.
File – The File menu allows you to create new files, open existing files, read in files from other software programs, save files and print.

Edit – The Edit menu allows you to modify or copy text from the output or syntax windows, and to search for and replace text or data. It also offered a number of personal preference options.

View - The view menu allows you to make the status bar and toolbar active, and to change particular characteristics of the window (for example, by removing grid lines, displaying value labels and changing font style and size.)

Data – The Data menu allows you to define variable and create variable templates. In addition, global changes to SPSS data files are available, such as measuring files, inserting, sorting and transposing variables and cases, and selecting weighting cases.

Transform – The Transform menu allows you to change certain variables in the data file using commands such as RECOD and RANK CASES, as well as create new variable using the COMPUTE command.

Analyze – The Analyze menu allows you to select the analysis you require. A variety of statistical procedure is available, rearranging from summarizing data through to more complex designs.

Graphs – The Graphs menu allows you to create bar, line, area and pie charts, as well as histograms and scatter plots.

Utilities – The utilities menu allows you to display file and variable information. In addition, it allows you to define and use different variable sets.

Reliability analysis of the data:

Reliability of measure indicates the extent to which it is without bias and hence ensures consistent measurement across time and across the various items in the instrument. Thus, reliability of a measure is an indication of the stability and consistency with which the instrument measures the concept and helps to assess the goodness of measure.
SPSS (16.0) has the reliability analysis procedure. This reliability procedure is executed on the data to assess its reliability.

In reliability analysis, the analyze menu is considered. The descriptive statistics menu is further considered and the polar to polar plot is plotted for different variables. Reliability analysis is carried out where the Cronbach’s alpha was tested. Ideally, the Cronbach’s alpha should be in between 0.5 and 1. In our case, it comes out to be 0.739. Therefore, the data is reliable. Following tables shows the SPSS output of reliability analysis.

Reliability

Scale: ALL VARIABLES

<table>
<thead>
<tr>
<th>Case Processing Summary</th>
<th>Reliability Statistics</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>N</strong></td>
<td><strong>%</strong></td>
</tr>
<tr>
<td>900</td>
<td>100.0</td>
</tr>
<tr>
<td>a. Listwise deletion based on all variables in the procedure.</td>
<td></td>
</tr>
</tbody>
</table>

The steps used in hypothesis testing:

The basic objectives of hypothesis testing are to prove or disprove the research question. By only allowing an error of 5% or 1% and making correct decisions based on statistical principles, from the outcome of statistical analysis researcher can conclude the result. The five steps are followed for testing hypothesis. These five steps consist of all the decisions a researcher has followed in order to answer research question.

Stating the research question – The first step used in the present study is to state the research question that identifies the population(s) of interest, the parameter(s) of the variable under investigation, and the hypothesized value of the parameter(s). This step helps in defining what is to be tested and what variable will be used in sample data collection. The type of variable whether it is categorical, discrete or continuous further defines the statistical test which can be performed on the collected data set.
The null and alternative hypotheses – The second step followed in the study is to state alternate and null hypothesis to select a significance level.

Calculate test statistics - The third step used in the study is calculation of a statistic analogous to the parameter specified by the null hypothesis.

Compute probability of test statistic or rejection region – The fourth step is calculation of the probability value (often called the $p$-value) which is the probability of the test statistic for both tails.

State conclusions – The fifth and final step is description of the results and state correct statistical conclusions in an understandable way. The conclusions consist of two statements-ones describing the results of the null hypothesis and the other describing the results of the alternative hypothesis.

3.7) Statistical tests used for hypothesis testing –

A) Spearman”s Rank Order Coefficient –

Sometimes it is important to determine the relationship between the two variables in terms of ranking of each case within each variable. This is usually the case where it is necessary to find ordinal relations. Under these circumstances it is required to use Spearman rank order coefficient.

Testing statistical significance using statistical significance–

When Spearman coefficient rank is in between 0.9 and 1, it indicates that there is a very strong correlation between two variables. When Spearman coefficient rank is in between 0.7 and 0.9, it indicates that there is a strong correlation between two variables. When Spearman coefficient rank is in between 0.5 and 0.7, it indicates that there is a moderate correlation between two variables.

Sometimes, the packages such as SPSS use p-value to test the hypothesis. When $p<0.01$ significance level, null hypothesis will be rejected and alternative hypothesis will be accepted.
B) Z – Test –

A statistical test used to determine whether two population means are different when the variances are known and the sample size is large. The test statistic is assumed to have a normal distribution in order for an accurate z-test to be performed. A Z-test is any statistical test for which the distribution of the test statistic under the null hypothesis can be approximated by a normal distribution. The Z-test has a single critical value (for example, 1.96 for 5% two tailed) which makes it more convenient. For the Z-test to be applicable, certain conditions must be met.

Nuisance parameters should be known, or estimated with high accuracy (an example of a nuisance parameter would be the standard deviation in a one-sample location test). Z-tests focus on a single parameter,

Following steps are followed. There are the following basic steps to completing a hypothesis z-test.

1. State the Null Hypothesis and the alternative hypothesis
2. State the decision criteria
3. Selection of confidence level

Confidence interval (CI) is a kind of interval estimate of population parameter and is used to indicate the reliability of an estimate. It is an observed interval and differs from sample to sample that frequently includes the parameter of interest, if the experiment is repeated. How frequently the observed interval contains the parameter is determined by the confidence level or confidence coefficient. Confidence intervals consist of a range of values that act as good estimates of the unknown population parameter. The level of confidence of the confidence interval would indicate the probability that the confidence range captures this true population parameter given a distribution of samples. Researcher has selected the confidence level equal to 95% which reflects a significance level of 0.05.

4. Determine the critical value of z
   Do this for the chosen significance level. For alpha=.05 we look up a Z that has 0.025 of the distribution beyond it. This is a Z of +1.96 and -1.96.
5. Interpret the data
6. Evaluate the hypothesis - Determine the standard error of the mean by the following formula:

\[ \sigma_{\bar{x}} = \sqrt{\frac{\sigma^2}{n}} \]

7. Calculate the Test Statistic: To determine how unusual the mean of a sample is, use the following Z formula to calculate the Z value for our sample mean under the assumption that the null hypothesis is true. The Z formula is:

\[ Z = \frac{\bar{X} - \mu}{\sigma_{\bar{x}}} \]

8. Decision Making Time: obtained Z value up in a Z table to find the corresponding P, and compare it to the Critical Z value. If the obtained P is less than alpha, we reject the null hypothesis.

C) Compound annual growth rate (CAGR) –

The growth rate in the business analysis or industry analysis is expressed in terms of compound annual growth rate which is given by the following formula –

Definition of ‘Compound Annual Growth Rate - CAGR’

—The year-over-year growth rate of retail trade, over a specified period of time is given in terms of compound annual growth rate which is calculated by taking the nth root of the total percentage growth rate, where n is the number of years in the period being considered.

The formula for CAGR is –

\[ CAGR = \left( \frac{Ending\ Value}{Beginning\ Value} \right)^{\frac{1}{n \text{ of years}}} - 1 \]

Thus, this chapter describes the research methods, significance of sampling plan. Sample procedure and use of statistical methods in the context of the data analysis used in the study. The outcome of the chapter indicates that there is need of gathering the primary data regarding grocery retail trade. The chapter clearly mentions about various steps followed while coding and decoding of the data. The chapter describes various variables used for the study. The next chapter describes about results and discussion about various elements in grocery retailing. The variables selected for the study are presented in respective sections of the next topic i.e. results and discussion, from section A of the chapter to section F of the chapter.